
 
Cover

How can you establish a connection 
between a S7-1200 PLC and SIMATIC 
NET OPC? 

S7-1200 PLC, SIMATIC NET OPC 

FAQ  November 2009 

 

Service & Support 

Answers for industry. 



Question 

 
 

 

2 
S7-1200_OPC_SIMATIC_NET 
Version 1.0, Item-ID: 39960679 

 

This entry is from the Service&Support portal of Siemens AG, Sector Industry, 
Industry Automation and Drive Technologies. The general terms of use 
(http://www.siemens.com/terms_of_use) apply. 

 

Clicking the link below directly displays the download page of this document. 

http://support.automation.siemens.com/WW/view/en/39960679  

 

 

 

 

 

 

 

 

Question 
How can you establish a connection between a S7-1200 PLC and SIMATIC NET  
OPC? 

 

Answer 
The instructions and notes listed in this document provide a detailed answer to this 
question. 
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1 Introduction 

1.1 Use case  

The possibility of connecting a S7-1200 with an OPC server is not mentioned in the 
manual given that it is not officially released by Siemens. In the following chapters 
you find a description on how to realize such a connection.  

As it is not possible to create a PC Station with STEP 7 Basic V10.5 you need to 
use the NCM PC tool of SIMATIC NET Edition 2008.  

Figure 1-1 

 

1.2 Requirements 

 PG/PC 

 STEP 7 Basic V10.5 

 SIMATIC NET Edition 2008  

– NCM PC tool 

– OPC Server 

– OPC Scout 

 S7-1200 PLC 

 Ethernet Cable (Crossed) 

Figure 1-2 
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2 Setting up your S7-1200 PLC by STEP 7 
Basic 
Configure your S7-1200 PLC and provide data to be watched via OPC connection. 

2.1 Hardware configuration  

For the hardware configuration use the project view of STEP 7 Basic V10.5.  

Create project  

Select the menu command project > new... The dialog box create a new project. 
opens. Enter the name S7-1200_OPC_SIMATIC-NET in the Project name input 
field. Click the Create button.  

Figure 2-1 

 

Add new PLC to project  

Double click the project tree command Add new device. The Add new device 
dialog box opens. In the work area  click the button SIMATIC PLC and select your 
PLC by clicking its MLFB. Click the OK button.  
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Figure 2-2 

 

Change IP address of Ethernet port  

Double click the command Devices & Networks in the project tree. In the Devices 
& Networks work area click the Ethernet port of your S7-1200 PLC. 

In the navigation area of the Properties tab select the Ethernet addresses 
instruction. Define the IP address 192.168.0.110 for the Ethernet port in the IP 
address input field.  

Click the Add new subnet button. In the Devices & Networks work area you find 
the subnet PN/IE_1 connected to your S7-1200 PLC.  

 



2 Setting up your S7-1200 PLC by STEP 7 Basic

 

S7-1200_OPC_SIMATIC_NET 
Version 1.0, Item-ID: 39960679 7 
 

Figure 2-3 

 

2.2 Software configuration  

To see any value changes you will now create a small program in which two 
hardware inputs and a hardware output of your PLC are connected to a software 
flip-flop. 

Add global data block 

In the Project tree click the expand button of your PLC folder (e.g. PLC_1 [CPU 
12…]).  Open the sub-folder Programm blocks by clicking its expand button and 
double click the instruction Add new block.  

In the dialog box Add new block select the button Data block (DB), enter the 
name Data_block_1 in the Name input field and uncheck the Symbolic access 
only check box. Click the OK button. The Data_block_1 work area opens.  
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Figure 2-4 

 

Create static data in global data block   

Create a bool-typed tag named static_01 in the Data_block_1 work area. 
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Figure 2-5 

 

Create program in Main [OB1]  

In the Program blocks folder of your PLC double click the instruction Main [OB1].  
Copy the program shown in the next picture.  

You find the bit logic operations in the Bit logic folder in the Instructions pane on 
the instructions task card. Drag’n’Drop the “Normally open contacts”, “the Output 
coil” and the “Set/Reset flip-flop” in network 1 of your Main [OB1] work area, 
according to the picture shown below. Make sure the input fields are filled in the 
same way as shown in the picture and in the table.  

Figure 2-6 

 

contacts 

Table 2-1 

SR FlipFlop input S: normally open contact I1.0 

SR FlipFlop input R: normally open contact I1.1 

SR tag DB1.DBX0.0 

SR FlipFlop output Q: output coil Q1.0 
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Hint 

The “%” in front of the addresses will be added by STEP 7 Basic V10.5 
automatically.  

2.3 Finalize S7-1200 PLC work 

Highlight the PLC_1 [CPU12…] folder in your project tree in order to compile, 
download and run your S7-1200 PLC.  

Compile and download program 

Press the Download to device button in the Toolbar.  

Figure 2-7 

 

The Extended download to device dialog box opens. Make sure the selected 
PG/PC interface and subnet are correct. Select PLC_1. Click the Load Button.  
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Figure 2-8 

 

If you have downloaded your project before, the load preview dialog box may 
open instead of the Extended download to device dialog box.  

Another dialog box may open before, asking to stop the S7-1200 PLC for 
downloading. Ackknowledge clicking the OK button.  

Figure 2-9 

 

The load preview dialog box opens. Click the load button.  
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Figure 2-10 

 

Switch S7-1200 PLC to run 

The load result dialog box opens. Check the Start all check box and press the 
Finish button. Your S7-1200 PLC status LED changes from stop to run. 

Figure 2-11 
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3 Create and configure PC-Station  
To access data of your S7-1200 PLC via OPC you have to create and configure a 
S7-connection in a STEP 7 project.  

3.1 Create new STEP 7project  

Open your SIMATIC NCM PC tool. To create a new STEP 7 project click on the 
menu command File > new. The new project dialog box opens. Write S7-
1200_OPC-Test in the name input field. Click the OK button.  

Figure 3-1 

 

3.2 Add SIMATIC PC station  

Click on the menu command Insert > station > SIMATIC PC-Station.  

A SIMATIC PC-Station is has been added to your project. 
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Figure 3-2 

 

3.3 Add OPC server 

Select OPC server  

Select the SIMATIC PC-Station in the project tree and click on the menu command 
Edit > Open Object. The HW Config dialog box opens.  

Figure 3-3 

 

Click on line one of  the (0) PC rack in the work area. Double click on SIMATIC PC-
Station > User Application > OPC Server > SW V7.0… in the catalog. The OPC 
server is inserted into line one of the rack.  
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Figure 3-4 

 

Configure OPC server properties 

Double click on the OPC Server module in line one of the (0) PC rack. The 
Properties dialog box opens. Click on the S7 tab. Set the Use Symbols radio 
button to None. Symbol use is not supported by S7-1200. Click the OK button.  

 



3 Create and configure PC-Station 
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Figure 3-5 

 

3.4 Add Ethernet interface IE General  

Select Ethernet interface  

Click on line two of  the (0) PC rack in the work area. Double click on SIMATIC PC-
Station > CP Industrial Ethernet  > IE General > SW V6.2 SP1… in the catalog.  
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Figure 3-6 

 
The Properties dialog box opens.  

Enter IP address  

On the Parameters tab enter the IP adress of yourPC in the IP address input field 
(e.g. 192.168.0.11).  
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Figure 3-7 

 

Add subnet to Ethernet Interface  

Click on the Button New…. The Properties dialog box for a new subnet opens.  
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Figure 3-8 

 

Click the OK button. The subnet properties dialog box closes. Click the OK 
button. The ethernet interface properties dialog box closes. The ethernet 
interface is inserted into line two of the rack.  

3.5 Save and compile project 

Click on the menu command Station > Save and Compile.  

Figure 3-9 

 



4 Setup Station Configurator 
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4 Setup Station Configurator  

4.1 Open from start menu  

Double click the Station Configurator symbol in the task bar. The Station 
Configuration Editor window opens.  

Figure 4-1 

 

4.2 Import station from STEP 7 project 

Click the Import Station… button. An acknowledge box opens. Click the Yes 
button. The Import XDB file dialog box opens. Select the file pcst_1.xdb and click 
the Open button. The Configuration for XDB Import dialog box opens.  

Figure 4-2 

 

Ignore any warning and proceed by clicking the OK button. The import is finished.  
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5 Connection in STEP 7 NetPro  

5.1 Set PG/PC interface  

Make sure  the configuration of your PG/PC interface is correct.  

Please find additional information on this topic on the internet at  

http://support.automation.siemens.com/WW/view/en/11870489. 

5.2 Download hardware configuration  

Make sure your S7-1200 PLC is connected to your PG/PC. Open your SIMATIC 
NCM PC project. Select the SIMATIC PC Station in the project tree and click on 
the menu command Edit > Open Object. The HW Config dialog box opens.  

Figure 5-1 

 

Click the Download button in the tool bar. Acknowledge the Select Target Module 
dialog box by clicking the OK button. The Select Node Address dialog box opens.  

 

http://support.automation.siemens.com/WW/view/en/11870489
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Figure 5-2 

 

Make sure the IP address of your SIMATIC PC-Station(1) is matching the IP 
address of your PC. Click the OK button.  
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Figure 5-3 

 

5.3 Configure network with NetPro  

Create S7-connection  

Click the menu command Options > Configure Network. The NetPro window 
opens.   



5 Connection in STEP 7 NetPro 
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Figure 5-4 

 

Select the OPC server slot of the PC-Station(1). Click on the menu command 
Insert > New Connection. The Insert New Connection dialog box opens.  

Figure 5-5 

 

Since the S7-1200 is an S7 Station we are able to use a S7-Connection. The 
partner should be unspecified since the S7-1200 is not available in the same Step 
7 project.   

Click the OK button. The Properties – S7 connection dialog box opens.  

Configure S7-connection  

Key the IP adress 192.168.0.110 of your S7-1200 PLC in the Partner Adress 
input field of the Properties – S7 connection dialog box.  

Click the Adress Details… button. The Adress Details dialog box opens. Enter 0 
in the Partner Rack input field and 1 in the Partner Slot input field. Click the OK 
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button. Close the Properties – S7 connection dialog box by clicking its OK button. 
Click the OK button.   

Figure 5-6 

 

Compile project  

Click the menu command network > save and compile.   

Figure 5-7 

 

Download connection 

Select the SIMATiC PC Station (1). Download the connection to the SIMATiC PC 
Station (1) by clicking the Download button. Acknowledge any opening dialog 
box. The connection should have been downloaded to your device yet.  



5 Connection in STEP 7 NetPro 
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Figure 5-8 
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6 OPC Scout  

6.1 Create new group  

Open OPC Scout. Double click OPC.SimaticNET in the server tree. The Add 
Group dialog box opens. Enter S7-1200_OPC_Test in the Group Name input 
field. Click the OK button.  

Figure 6-1 

 

6.2 Select connection and create items  

Double click the new group S7-1200_OPC_Test. The OPC – Navigator dialog box 
opens.  

Figure 6-2 

 

Browse the Nodes tree to Connections > \S7 > S7 connection_1 > objects > I > 
[New Definition]. Double click the option [New Definition]. The Define New Item 
dialog box opens.  

 



6 OPC Scout 
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Fill in the data as shown in the table 6-1.  

Table 6-1 

Datatype Address Bit No. No. Values 

X 1 0 1 

 

Click the OK button. Take over the new item in the right column four times by 
clicking the --> button.. 

Double click on each item and modify its name as shown in table 6-2.  

Table 6-2 

S7:[S7 connection_1]IX1.0  

S7:[S7 connection_1]IX1.1  

S7:[S7 connection_1]DB1, X0.0, 1  

S7:[S7 connection_1]QX1.0  

Click the OK button to end the OPC Navigator window.  

6.3 View values  

In the Values column you can see the actual values of the listed items. If you are 
connected to your S7-1200 PLC the Quality of the item is listed good.   

Figure 6-3 
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